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A quick word about me

Sarawuth Wantha, Ph.D

Product Application Specialist, 
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• Ph.D. in Biomedical Engineering: Focus on Biomedical 

Imaging and Image Processing

      Ludwig-Maximilians University Munich, 2013 

• Joined Thermo Fisher Scientific in 2018



Agenda

Beginner: April 21 (Monday)

•Introduction to image/volume data and processing

•Software overview, general concepts and user interface

•Data visualization in 2D&3D and annotations

•Basic Data Manipulation: cropping, re-sampling, pixel type and conversion

•Image processing: denoising, filters, background correction

•Automatic Segmentation: binarization and thresholding

•Separation, classification, analysis & measurement

•Screen capture and animation

•Recipe and batch processing



Agenda

Intermediate: April 22 (Tuesday)

•Introduction to image segmentation

•New Segmentation+ workroom (requires Avizo 2024.2 and later)

•Multi-material segmentation

•Watershed segmentation

•Surface reconstruction and simplification

•Data registration and alignment

•AI-assisted segmentation tools



Agenda

Advanced: April 23 (Wednesday)

•Review of segmentation tools

•2D & 3D Deep Learning Training module

•Deep Learning Prediction Module

•Deep Learning Denoising Module

•Core Profile (features from PerGeos)

•Overview of Avizo extensions

•Focus on specific extensions

•Avizo ToGo



KAUST Visualization Core Lab (KVL) Facilities

powerful workstations for Avizo

processing and visualization

https://wiki.vis.kaust.edu.sa/booking

Book AR/VR Hub. Access is free 

but please acknowledge KVL in 

resulting publications! 



KAUST Visualization Core Lab (KVL) Facilities

https://wiki.vis.kaust.edu.sa/booking

pen + tablet interface 

for manual segmentation

Book AR/VR Hub. Access is free 

but please acknowledge KVL in 

resulting publications! 



Avizo Software for Materials Research & Quality Control
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Quickly and accurately obtain properties from your imaging data

Metals and Alloy
Ceramics, 

Glasses and 

Porous

Composite, 

Polymer

Additive 

Manufacturing

Battery

Energy Materials
Biomaterials

Food and 

Agriculture

Avizo Software provides unmatched imaging data analysis tools for numerous scientific and 

industrial applications from a single environment



Multi-Modality Imaging

Nanometer Micrometer Centimeter

Light microscopy

• Confocal

• Fluorescence

• Serial sections

Electron microscopy

• SEM

• TEM-Tomography

• FIB/SEM

Computed tomography

• CT

• µ-CT

• Synchrotron-CT

Magnetic resonance imaging

• MRI

• DTI

Other

• PET

• 3D Ultrasound

• OTC



Complete workflows for visualization and analysis

Presentation

and reporting

Segmentation

Data import Visualization Measurement / analysis

Data acquisition

Filtering / pre-processing



Introduction to Image Analysis
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Introduction to Image Analysis

12

What is Image Analysis ?

Image analysis involves processing an image 

into fundamental components to extract 

meaningful information. 

Image analysis can include tasks such as finding 

shapes, detecting edges, removing noise, counting 

objects, and calculating statistics for texture 

analysis or image quality.



Image & Metadata
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Image metadata is information about a visual file or resource. 

This data describes what the file is, details about it, and how it should be used.

Technical metadata

• Image type 

• Image size 

• Microscope settings

• Date created

• Uploader credentials

Descriptive metadata

• Image descriptions

• Keywords 

• Batch or collection

• Author’s name

Administrative metadata

• Rights management

• Restrictions 

• Licensing

• Expiration date

Background information of images



What is a digital image

14

Definition of Pixel

• A pixel is a point sample of the intensity in space

•  PSF (Point Spread Function)

• Pixel size = pixel spacing distance 

Yes!

No!

Sampling                        Data set                           Visualization



What is a digital image

15

Grayscale image consists of a finite number of pixels (2D) or voxels (3D)

5

32

147
Pixels

Voxels

Cardona A, et al. 2010. An Integrated Micro- and Macroarchitectural Analysis of the Drosophila Brain by Computer-Assisted Serial 
Section Electron Microscopy.



What is a digital image

16

Bit depth of an image defines how many different grey values can be detected in the data 

1-bit image (21)    has 2 possible numerical intensity values 

2-bit image (22)    has 4 possible numerical intensity values

8-bit image (28)    has 256 possible numerical intensity values

32-bit image (232)    has 2,147,483,647 possible numerical intensity values 

16-bit image (216)    has 65,536 possible numerical intensity values



Intensity Image

17

Grayscale Pixels



Intensity Image

18

Grayscale Pixels

8-bit image (28)    has 256 possible numerical intensity values from 0 to 255 

16-bit image (216) has 65,536 possible numerical intensity values from 0 to 65,535

32-bit image (232) has 2,147,483,647 possible numerical intensity values 



What is a digital image

19

Look-up tables assign color and transparency to each intensity value

Grayscale Physics



Data visualization: Colormap

Gray

Blue

Physics

Data                               Visualization



Color Mapping

21

Grayscale to RGB Images

Grayscale Color Mapping



Image Visualization

22

2-Dimensional vs 3-Dimensional images (2D vs 3D) 

2D Plane                   vs                       3D Volume           



Image Visualization
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• 2D & 3D interactive scene

• Direct manipulation of objects

• Numerous visualization options:

• 2D Slices, with overlays

• 3D Volume rendering

• Surface rendering

• Projections

• Meshes, graphs

• Isosurfaces

• Histograms and curves

Visualization of 2D & 3D Image Data



Image Visualization

24

• 2D & 3D interactive scene

• Direct manipulation of objects

• Numerous visualization options:

• Ortho Slices

Visualization of 2D & 3D Image Data



Image Visualization

25

• 2D & 3D interactive scene

• Direct manipulation of objects

• Numerous visualization options:

• Slices, with overlays

• 3D Volume rendering

Visualization of 2D & 3D Image Data



Image Visualization

26

• 2D & 3D interactive scene

• Direct manipulation of objects

• Numerous visualization options:

• 2D Slices, with overlays

• 3D Volume rendering

• Surface rendering

Visualization of 2D & 3D Image Data



Image Visualization

27

• 2D & 3D interactive scene

• Direct manipulation of objects

• Numerous visualization options:

• 2D Slices, with overlays

• 3D Volume rendering

• Surface rendering

• Projections

• Meshes

Visualization of 2D & 3D Image Data



Image Visualization

28

• 2D & 3D interactive scene

• Direct manipulation of objects

• Numerous visualization options:

• 2D Slices, with overlays

• 3D Volume rendering

• Surface rendering

• Projections

• Meshes, graphs

• Isosurfaces

Visualization of 2D & 3D Image Data



CT Reconstruction Artefacts

Image Pre-Processing

28

• Cone-beam 

• Beam-hardening

• Phase-contrast

• Object motion

• Ring artefacts

• Scattering

• Metal-artefacts

• Inaccurate geometry

• Too few angles

• Missing angles



• Noise reduction

• Gaussian, median, Anisotropic diffusion

• Non-local means

• Image artefacts reduction

• Curtaining

• Pore-back / shine-through

• Slice alignment

• Background correction

• Shading correction

• Deconvolution

Denoising and Artifact Removing

Image Pre-Processing

28



• Noise reduction

• Gaussian, median, Anisotropic diffusion

• Delineate

• Unsharp Masking, Non-local means

Denoising and Artifact Removing

Image Pre-Processing

29

Median filterOriginal image



• Noise reduction

• Gaussian, median, Anisotropic diffusion

• Non-local means

• Image artefacts reduction

• Curtaining

• Slice alignment

Denoising and Artifact Removing

Image Pre-Processing

30



• Noise reduction

• Gaussian, median, Anisotropic diffusion

• Non-local means

• Image artefacts reduction

• Curtaining

• Slice alignment

• Background correction

• Shading correction

Denoising and Artifact Removing

Image Pre-Processing

31



Image Segmentation

34

Extracting meaningful information from images

Image segmentation is a method of dividing a 

digital image into subgroups called image 

segments, reducing the complexity of the image 

and enabling further processing or analysis of each 

image segment. 

Technically, segmentation is the assignment of 

labels to pixels to identify objects, cells, organelles 

or other important elements in the image.



Image Segmentation Principles

35

Thresholding: Binarization of graysale image into Label Image 

8-bit image (28)    has 256 possible numerical intensity values from 0 to 255 

16-bit image (216) has 65,536 possible numerical intensity values from 0 to 65,535

32-bit image (232) has 2,147,483,647 possible numerical intensity values 



Image Segmentation Principles

36

Thresholding: Binarization of graysale image into Label Image 

8-bit image (28)    intensity values from 0 to 255   

16-bit image (216) intensity values from 0 to 65,535               Binary Image (2 possible) values 0 or 1

32-bit image (232) intensity values from 0 to 2,147,483,647 



Image Segmentation Principles

37

Thresholding: Binarization of graysale image into Label Image 

Grayscale (intensity) Image Thresholding (Binary mask) Binary (Label) Image

8-bit image (28)    intensity values from 0 to 255   

16-bit image (216) intensity values from 0 to 65,535                            Binary Image (2 possible) values 0 or 1

32-bit image (232) intensity values from 0 to 2,147,483,647 



Image Segmentation Principles

38

Binarization and Separation Methods

• Watershed segmentation
Automatic edge detection

Marker-based watershed with interactive / automatic markers

• Mathematical morphology
Grayscale/binary morphology, variety of structuring elements

Structure enhancement filter

Membrane enhancement filter

• Correlation-based Segmentation
Segmentation of regions that are co-localized in 

different channels of a multi-channel image

• Thresholding
Global Thresholding, Local Thresholding, Multi-

Thresholding, Auto-Thresholding

Data courtesy: Cell data: Mason Dean & Ronald Seidel (MPI Postdam-Golm), David Knoetel (Zuse Institute Berlin)

Brain data: Leslie Vosshall’s Laboratory at HHMI-The Rockefeller University.
Membrane data: of Biophysical Fluorescence Laboratory Center For Bioimaging Sciences Departments of Biological Sciences & Chemistry National University Of Singapore



Analysis

• Area, Volume, Surface

• Counting

• Intensity

• Distance, thickness

• Clustering

• Orientation, Length, Rugosity

• Co-localization

• Density 

39

Shape and Size Distributions



Complete Workflows

• Data import

 - Reading image file formats & metadata

• Visualization

 - Display in 2D or 3D 

• Image Preprocessing 

 - Denoising

• Segmentation

 - Binarization (Thresholding)

 - Separation

• Feature Extraction

 - Statistic

40

Summary: Step-by-step



Complete Workflows

• Data import & Visualization

 - Reading image file formats & metadata

41

Step by step



Complete Workflows

• Data import

 - Reading image file formats & metadata

• Visualization

 - Display in 2D & 3D 

• Image Preprocessing 

    - Smoothing & Denoising

42

Step by step



Complete Workflows

• Data import

 - Reading image file formats & metadata

• Visualization

 - Display in 2D & 3D 

• Image Preprocessing 

 - Denoising

• Segmentation

 - Binarization 

 (Thresholding)
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Step by step



Complete Workflows

• Data import

 - Reading image file formats & metadata

• Visualization

 - Display in 2D & 3D 

• Image Preprocessing 

 - Denoising

• Segmentation

 - Separation 

  

44

Step by step



Complete Workflows

• Data import

 - Reading image file formats & metadata

• Visualization

 - Display in 2D & 3D 

• Image Preprocessing 

 - Denoising

• Segmentation

 - Binarization (Thresholding)

 - Separation

• Feature Extraction

 - Statistics

45

Step by step



Complete Workflows

• Data import

 - Reading image file formats & metadata

• Visualization

 - Display in 2D & 3D 

• Image Preprocessing 

 - Denoising

• Segmentation

 - Binarization (Thresholding)

 - Separation

• Feature Extraction

 - Statistic

46

Step by step



General concepts and tools
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Learning resources:

• Tutorials

• YouTube Learning Center

• User’s Guide

Avizo start page accessHelp menu access

Getting started



Learning resources:

• Tutorials

• YouTube Learning Center

• User’s Guide

Amira start page accessHelp menu access

Getting started



Avizo start-up page



Amira start-up page



Main menu bar Viewer toolbarWorkroom bar

Workspace: user interface components

Project 

View

Properties

Area

Viewer Window



Loading a dataset into Project Workroom – part 1

3D CT 

scan data 



Loading a dataset into the Project Workroom – part 2

Data 

object
Display 

module

Default data display 

Configuration: Edit>Preferences> Auto Display



Loading a dataset into the Project Workroom – part 2

Data 

object
Display 

module

Default data display 

Configuration: Edit>Preferences> Auto Display

Display module colors

Data objects

3D Visualization

Planar (2D) visualization modules 

Compute modules 

Tcl script objects  

Python script objects  

Color maps 



Attach a module to a dataset: e.g. Bounding Box

Right click 

on data

Search by 

name

Browse 

categories

Ways to trigger module:

• Double-click

• Press Enter

• Press Create button



Module properties: e.g. Bounding Box

Properties:

• Click on a module in the pool 

to display its properties (data 

module included)

• Click on “?” to access the 

module’s documentation

• Module properties are called 

ports

Access documentation

Properties of the objects selected 

in the Poject View



Navigate and interact in 3D – part 1

Bounding Box

Original View 

Interact

[ESC]

Trackball

[ESC], [Alt]



Navigate and interact in 3D – part 1

Zoom

Mouse wheel/left button

Rotate

Click icon /+ [Shift]/[Ctrl]
Translate

Left mouse button



Navigate and interact in 3D – Part 2

Zoom

Mouse wheel/left button

Rotate

Click icon /+ [Shift]/[Ctrl]
Translate

Left mouse button



Most of the actions can be done in the trackball mode:

• Hold left mouse button for rotation

• Use the mouse wheel for fine zoom 

• Hold left and middle mouse button for fast zoom

• Hold the middle mouse button for translation

When in interact mode:

• Press and hold [Alt] to switch to trackball mode 

Press [Esc] for switching between interact and trackball 

modes.

Navigate and interact in 3D – good practice



Visualize a dataset: e.g. Ortho Slice

• Ortho Slice connects 

Automatically if Auto 

Display is on

• Can otherwise be created 

like any other module

• A dataset is displayed in 

the viewer only if it has a 

visualization module 

attached

• Check that visibility is 

turned on (e.g. workflow 

with multiple data)

Turn visibility on/off



Visualize a Dataset: e.g. Ortho Slice properties

Some properties settings: 

• Orientation port: choose the display plane of 

the slice

• Slice number: choose the slice to be 

displayed in the viewer -  drag slider or use 

mouse wheel / insert value in the text box

• Adjust view: if on, the camera is reset each 

time a new slice orientation is selected



Visualize a Dataset: e.g. Ortho Slice properties examples
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Setting preferences – part 1

Preference setting e.g.: 

• Set the number of 

recent files and 

projects displayed 

on start page



Setting preferences – part 2

Preference setting e.g.: 

• Add compass in the 

3D Viewer



Visualize a Dataset: e.g. Ortho Slice properties examples
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Visualization of 2D and 3D data
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Assemble the necessary modules to 

create a view like in the screenshot

Dataset available at:

• $INSTALLDIR/data/tutorials/ 

chocolate-bar.am

Data visualization: Exercise 1

Setting the orientation of the 2D view



Solution:

• Connect 3 Ortho Slice modules, each having 

a different orientation setting

• Note: Multiple modules with different ports 

settings can be connected to the same data

Data visualization: exercise 1

Solution



Data visualization: exercise 1

Pin button

Data visualization: exercise 1

Tip

Tip:

• Module ports can be pinned by clicking the 

pin button: pinned ports are always displayed 

in the Properties window, even if the module 

is deselected



Visualize a dataset: e.g. Ortho Slice

• Ortho Slice connects 

Automatically if Auto 

Display is on

• Can otherwise be 

created like any other 

module

• A dataset is displayed in 

the viewer only if it has a 

visualization module 

attached

• Check that visibility is 

turned on (e.g. workflow 

with multiple data)



Slice: visualize arbitrarily oriented slices in a volume

Slice – interpolation:

• Not necessarily axis-aligned, interpolation is 

necessary for reconstruction

• Interpolation can be tuned from Sample ports

• Different sampling resolutions (fine, coarse, 

etc.) are available in the drop-down menu.

• Sample ports – no effect if the slice is axis-

aligned.

2D visualization with Slice 



Isocontour Slice:

• Clipping Plane

• Isocontour 

• Rotation

• Iso-Intensity values 

• Colormap

2D visualization with Isocontour Slice 

Isocontour Slice: computes isolines and their annotations 

for an arbitrary 3D scalar field on a 2D cutting plane. 



Virtual trackball

2D visualization with Slice 

Slice – rotate:

• Activate virtual trackball: Press [Tab] or select 

“rotate” (from Options)

• Hold the left mouse button in interactive mode:

• Click inside the white lines of a trackball axis 

=> rotate along the respective axis

• Click outside the trackball axes => rotate in 

all directions



Slice: visualize arbitrarily oriented slices in a volume

Slice – defining a plane:

• Select “fit to points” (from Options)

• Click on 3 different points inside the object

Press [Esc] to activate Interact mode.

• After clicking 3 points, “fit to points” is 

automatically disabled. 

2D visualization with Slice 



Isosurface: visualization of surfaces of same value

Isosurface – visualization module that 

requires processing. For launching the 

processing:

• Press the Apply button

• Check auto-refresh (use with caution)

3D visualization with Isosurface 



Isosurface: visualization of constant value surfaces

A threshold value is necessary for 

computing the Iso-surface:

• set by default from data histogram

• can be manually adjusted (bottom slider) 

Top sliders – zoom on the histogram

3D visualization with Isosurface 



Histogram Thresholding

• Histogram – the distribution of voxel intensity values

• Can be computed by “Histogram” module

• Its shape is informative for thresholding a dataset

• In the case of chocolate bar data, the histogram has 

3 lobes for: 

• background and porosities

• for the “mousse” (inside)

• for the chocolate and caramel (outer layers)

By setting a histogram threshold value as indicated below, 

The outer chocolate bar layers will be selected, as they 

correspond to the third histogram lobe (highest intensity 

values).

3D visualization with Isosurface 



Isosurface: 

• For generate the surface computed by Isosurface, 

use “Extract Surface” module.

• For visualizing the generated surface, use 

“Surface View” module.

 

3D visualization with Isosurface 



Planar visualization (orange) modules can be used for clipping.

Clipping applies to all the objects that have the visibility on.

Clip

Clipping:

• Define the clipping plane by e.g. Slice

• Click on the “Clip” icon – clip on one 

side of the object

• Click again – disable clipping

• Click again – clip on the other side

Planar visualization modules - clipping



Setting Slice transparency:

• Choose Binary mode (from Transparency) – regions of voxel intensity values outside the colormap 

range are fully transparent while others are fully opaque.

• Adjust the colormap range to obtain the view in the example above.

Planar visualization modules - clipping



Assemble the necessary modules to create a similar view:

Data visualization: exercise 2

Clipping volumes and setting transparency



Generate 2 isosurfaces for two thresholds:

• Low threshold: ~ 410

• High threshold: ~ 940

Data visualization: exercise 2

Solution – Step 1 



Clip the 1st Isosurface with Slice:

• All visible modules are clipped => the visibility of all other modules except the 1st Isosurface should be 

turned off.

Tip: Select 1st Isosurface and press [h] => only he selected module has the visibility switched on.

• Select the clipping plane with Slice and then clip.

Data visualization: exercise 2 Data visualization: exercice 2

Solution – Step 2 



Set transparency

Double click to 

change color 

Setting visibility, colors and transparency:

• Turn off the visibility of Slice

• Change the color of the 1st Isosurface: double 

click on the colormap to pick color

• Set a transparency to the 2nd Isosurface – 

select “transparent” (“Draw style” port)

Full solution available at:

Data visualization: exercise 2

Solution – Step 3 



Saving a project: File > Save Project (As) …

• Use “Minimize project computation” when a module 

takes a long computation time

• Use “Minimize project size” otherwise

Project save

• Use ‘[pack & go]’ option if you need to archive or transfer the project to a different computer.

• This will copy the input dataset(s) inside the project folder. Otherwise, these files are only 

referenced via their path on the disk, and the project will not load if this path is no longer valid.



Saving a project: File > Save Project (As) …

• Use “Minimize project computation” when a module 

takes a long computation time

• Use “Minimize project size” otherwise

Project save

• Use ‘[pack & go]’ option if you need to archive or transfer the project to a different computer.

• This will copy the input dataset(s) inside the project folder. Otherwise, these files are only 

referenced via their path on the disk, and the project will not load if this path is no longer valid.



• A colormap is used to map scalar values to intensity levels or colors

• The colormap range can be modified manually in order to adjust brightness, darkness or contrast

• Predefined colormap settings are also proposed.  

Some examples of grayscale colormap setting for Ortho Slice module

(click on the ”Edit” button of “Colormap” port):

Setting a colormap: e.g. Ortho Slice



Volume rendering – colormap settings for assigning color and transparency to each voxel value

“Opacity” port – for tuning the transparency

Colormap Settings 

Advanced Rendering Settings 

3D visualization with Volume Rendering



Data visualization: Colormap

Gray

Blue

Physics

Data                               Visualization



For changing the default colormap:

• Click on the “Edit” button of “Colormap” port

• Pick a colormap from the drop-down list 

OR

• Load a colormap from the disk

Once loaded, a colormap will be added to the drop-down list

Volume rendering: Colormap Settings

volrenGreen

Colormap

(default)

volrenPhysics

Colormap

(loaded from disk)

3D visualization with Volume Rendering



Rendering type:

• Standard

• Physical – mostly used 

According to the selected rendering type, 

different rendering options are proposed.

Click on the arrow on the left of the “Rendering” 

port in order to show more settings.

Volume rendering Settings

Switch on the “Advanced” ribbon for advanced 

Volume Rendering settings

• “Move Low Res”– low resolution mode when 

moving the camera, for real time rendering

3D visualization with Volume Rendering



Volren:

• Fast preview

• Limited by RAM memory

• Corner Cut possible

Volume Rendering:

• Realistic visualization

• Limited by VRAM memory

• Corner Cut not possible

Volren: Support Corner Cut module

3D visualization with Volren



Connected to:

• Slice

• Volren

• Volume Rendering

• Iso-Surface

• Triangulated Surface

ROI Box: Region of Interest

3D visualization with ROI Box



In addition to choosing a default colormap or loading one from the disk, one can also edit a colormap by 

means of Colormap Editor. To access Colormap Editor: 

• Click the “Edit” button of the “Colormap” port of any visualization module and select Options -> Edit 

Colormap

Colormap Editor window will be displayed on top of the Project View window:

Setting a colormap: Colormap Editor



Opacity curve – allows controlling the transparency of the colormap:

• Pick a default preset from the “Opacity preset” menu 

• Manually adjust the curve:

• Left-click on the curve to add a point at the respective location

• Click and hold on a point in order to move it

• Right click on a point in order to remove it  

Click on the arrow on the Editor’s bottom-right corner for opening the Color Editor (below the histogram):

Setting a colormap: Colormap Editor



Colormap gradient – allows modifying the colormap using color markers

• To modify the color gradient:

• Left-click on the markers line to add a marker at the respective location

• Click and hold a marker in order to move it

• Right click on a marker in order to remove it

• Double click on a marker for color settings 

• Drag the diamond shaped button to adjust the location of the inflection point

• The data points outside the colormap range will be mapped to the color defines by the extreme left and 

right boxes.  

Setting a colormap: Colormap Editor



Use the Volume Rendering module and tune the colormap to obtain a similar view:

Data visualization: exercise 3

Setting colormaps



Colormap Editor Settings:

• Add and move points on the opacity curve for setting the transparency of the colormap

• Add and tune color markers for setting the color gradient of the colormap

Data visualization: exercise 3

Solution



Volume Rendering Settings:

• Adjust the lighting effects: specular and deferred for highlighting reflections and shadows

• Choose interpolation mode: cubic for smoother result

Data visualization: exercise 3

Solution



Basic data manipulation
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What is a digital image

103

Grayscale image consists of a finite number of pixels (2D) or voxels (3D)

5

32

147
Pixels

Voxels

Cardona A, et al. 2010. An Integrated Micro- and Macroarchitectural Analysis of the Drosophila Brain by Computer-Assisted Serial 
Section Electron Microscopy.



What is a digital image
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Definition of Pixel

• A pixel is a point sample of the intensity in space

•  PSF (Point Spread Function)

• Pixel size = pixel spacing distance 

Yes!

No!

Sampling                        Data set                           Visualization



What is a digital image
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Bit depth of an image defines how many different grey values can be detected in the data 

1-bit image (21)    has 2 possible numerical intensity values 

2-bit image (22)    has 4 possible numerical intensity values

8-bit image (28)    has 256 possible numerical intensity values

32-bit image (232)    has 2,147,483,647 possible numerical intensity values 

16-bit image (216)    has 65,536 possible numerical intensity values



What is a digital image
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Look-up tables assign color and transparency to each intensity value

Grayscale Physics



Click on a data in the pool in order to have data and voxel properties displayed in the properties window:

e.g. chocolate bar:

• Type: grayscale, label, RGBA, etc.

• Precision: number of bits used for coding the value stored by a voxel. E.g.:

• 8-bits <-> values in [0-255]

• 32-bits float <-> values in ~ [-1e38, 1e38], finer precision but 4x more memory required

• Minimum and Maximum voxel values – give the intensity range (do not confuse with colormap range)

• Window: voxel values range outside the background

Data and voxel properties



Changing type: Convert Image Type module

Scaling is necessary to avoid 

clipping. For scale tuning 

check:

• The intensity range of the 

input data

• The intensity range of the 

converted data

Converting types and re-mapping intensities 



Changing type: Convert Image Type module

Re-mapping intensities: Different modules are available in the 

category: Image Processing -> Grayscale Transform

Scaling is necessary to avoid 

clipping. For scale tuning 

check:

• The intensity range of the 

input data

• The intensity range of the 

converted data

Converting types and re-mapping intensities 



Access Crop Editor: select a dataset 

in the pool and click on the Crop 

Editor icon in the data properties 

window

Crop Editor – main functionalities:

• Crop: reduce/enlarge image frame

• Manually

• Automatically (by an automatically set gray-level threshold 

for separating the data into background and object) 

• Change resolution

• Change voxel size

• Change bounding box size (the new voxel size is 

automatically computed 

The number of voxels is preserved

• Modify axes: 

• Flip an axis’ orientation – the slices along the respective 

orientation will have their order reversed

• Swap – allows interchanging two axis

Crop Editor: main functionalities



Note: Bounding Box is defined from voxel centers, i.e. :

bbox_size = voxel_size * (#voxels – 1) for each dimension (x, y or z)

A slice is defined from voxels centers too.

Bounding Box

Voxel

Warning: editors directly modify the data 

no undo available (the only way to get the original 

data back is by reloading/re-generating it)

Good practice: duplicate data before editing:

• Keyboard shortcut: [Ctrl] + [d]

• Data object menu

Crop Editor: good practices



Extract Subvolume module can be used as an alternative to Crop Editor (for cropping only).

Extract Subvolume + ROI Box – allow cropping multiple datasets the same way:

e.g. input dataset and its segmentation result

• Extract the desired sub-volume of the input dataset (by means of Extract Subvolume)

• Connect a ROI Box to the extracted sub-volume

• Connect an Extract Subvolume module to the second dataset. Connect the ROI input of the Extract 

Subvolume module to the ROI Box module and then press Apply

=> The second dataset will be cropped as the first one.

 

Crop Editor: alternatives



Resampling 

Allows enlarging/shrinking the regular grid on which 

an image is defined (interpolation is necessary):

• Change the number of voxels                                                                                                  

e.g. reduce => reduced data size but lowered 

quality

• Change voxel size                                                                                                            

e.g. adjust size in order to make the voxels 

isotropic

This can be done in Avizo via the Resample module.

Data resampling



Resampling 

Allows enlarging/shrinking the regular grid on which 

an image is defined (interpolation is necessary):

• Change the number of voxels                                                                                                  

e.g. reduce => reduced data size but lowered 

quality

• Change voxel size                                                                                                            

e.g. adjust size in order to make the voxels 

isotropic

This can be done in Amira via the Resample 

module.

Data resampling



Resample Transformed Image module 

Oftentimes, when a data is transformed in Avizo, only the visualization of the data is changed and not its 

representation in memory. Apply this module to implement the transformation carried by a dataset and to 

change the dataset representation in memory.

Use cases examples:

• Generate the data resulted after applying a rotation, scaling or other transformation 

• Generate the resampled image after registration with a reference

• Apply the rotation necessary to a dataset after aligning the data bounding box with the object’s axes.

Data resampling – apply transformation 



Resample Transformed Image module 

Oftentimes, when a data is transformed in Amira, only the visualization of the data is changed and not its 

representation in memory. Apply this module to implement the transformation carried by a dataset and to 

change the dataset representation in memory.

Use cases examples:

• Generate the data resulted after applying a rotation, scaling or other transformation 

• Generate the resampled image after registration with a reference

• Apply the rotation necessary to a dataset after aligning the data bounding box with the object’s axes.

Data resampling – apply transformation 



Issue: the object’s axes and the bounding box’s axes are not aligned 

Goal: align the bounding box’s axes to the object’s axes

Before alignment After alignment

Slice (aligned to the 

object’s bottom plane)

Ortho Slice

Bounding Box

Data resampling example

Resampling to an oblique plane



Solution:

• Use “fit to points” option of Slice on an Isosurface or Volume Rendering and fit the Slice to the object’s 

xz plane (the bottom of the chocolate bar).

• Apply a Resample Transformed Image module and connect:

• “Data” input to the data object

• “Reference” input to the Slice

Select “extended“ option and press Apply

A new data is generated with the bounding box’s axes aligned to the object’s axes.

 

Data resampling example

Resampling to an oblique plane



The results of the different processing modules 

can be exported from the Avizo pool.

Exporting data on the disk:

• Right-click on the dataset you want to save

• Click on the “Export data as” icon

• Select the relevant format

Export data



The results of the different processing modules 

can be exported from the Amira pool.

Exporting data on the disk:

• Right-click on the dataset you want to save

• Click on the “Export data as” icon

• Select the relevant format

Export data



Image pre-processing: adjustments
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Basic image data editing – Volume Edit

Volume Edit: interactive editing with various tools

Two types of tools are available:

• A draw tool:

allows selecting the 3D projection behind a contour drawn in the viewer

• Dragger tools:                                                                                                                              

allow selecting a region by dragging, rotating, resizing a 3D shape (box, ellipsoid, cone, etc.). 



Basic image data editing – Volume Edit

Volume Edit – example of creating a sub-volume with the draw tool:

Draw tool selection “Cut outside” result

Data: MoSi2-shear-corrected.am



Basic image data editing – Volume Edit

Volume Edit - example of creating a Cylindrical Mask:

• Tool port settings: TabBox, Cylinder, Z Axis

• Adjust cylinder using Orthographic Camera mode

• Set Padding value to the value of the voxels of the “exterior” (e.g. 0)

• Push buttons: Cut – Outside and Edit – Create Mask



• For serial sections (e.g. Light Microscopy)

• Pushing the Edit button activates the Alignment viewer    

and tools and the Align and Landmarks menus

• Visualization of two consecutive slices in overlay

Align Slices

Data: leaf image stack



Align Slices

• Available operations:

• Translate

• Rotate

• Mirror

each slice with respect to the next one.

• Modes and options (some examples):

• Manual

• Land-Mark

• Intensity-based

• Possibility to use a mask

• Resample aligned stack (by pressing the Resample 

button of the module).

Automatic alignement modes



• Rotation alignment should be disabled for 

FIB-SEM (Align / Options)

• No rotation while FIB-SEM data collection!

• For disabling rotation go to Align menu – 

Options in order to access the AlignSlices 

Options pop-up.

Align Slices



Align Slices

Alignment example – comparison of raw data set (left-side) with aligned data set (right-side)

First xy slices of the volume

Last xy slices of the volume



Image pre-processing: filtering
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Filtering – enhance the data quality

Most filters operate in the spatial domain 

– each pixel/voxel is evaluated and its 

filtered valued is given by applying a 

formula to the values of its neighbors in 

the input data:

• The neighborhood type needs to be 

defined

• The formula is filter specific.

 

Pixel neighborhood

Pixel

Introduction to spatial domain filtering



Image filtering: how to apply a filter in Avizo

Various filtering modules are available in Avizo.

They are mainly grouped according to their types into different sub-categories of the Image Processing 

category :

• Edge Detection

• Enhancement Filters

• Sharpening

• Smoothing and Denoising

• …

Right click on the data set in order to 

Access the module category menu.

 



Image filtering: how to apply a filter in Amira

Various filtering modules are available in Amira.

They are mainly grouped according to their types into different sub-categories of the Image Processing 

category :

• Edge Detection

• Enhancement Filters

• Sharpening

• Smoothing and Denoising

• …

Right click on the data set in order to 

access the module category menu.

 



Image filtering: how to apply a filter in Avizo

Filter Sandbox module allows testing different filters 

in order to make the best choice for a given dataset:

• Select a filter 

• Tune its parameters 

• Appy result on a sub-volume of the dataset 

(useful for large datasets)

E.g. Anisotropic Diffusion

 



Image filtering: how to apply a filter in Amira

Filter Sandbox module allows testing different filters 

in order to make the best choice for a given dataset:

• Select a filter 

• Tune its parameters 

• Appy result on a sub-volume of the dataset 

(useful for large datasets)

E.g. Anisotropic Diffusion

 



Box Filter performs the arithmetic mean of the pixel/voxel values in the neighborhood window 

Filtering

5, 3, 4, 3, 10, 5, 3, 4, 5

Image filtering: Box



Median Filter outputs the median value of the pixel/voxel values in the neighborhood window 

Filtering

3, 3, 3, 4, 4, 5, 5, 5, 10

Image filtering: Median



Non-Local Means outputs the weighted average of the values in the local neighborhood. The weight of 

each pixel/voxel is given by how similar its neighborhood (non-local) is to the local neighborhood.

Filtering

Non-local neighborhood

Local neighborhood

Image filtering: Non-Local Means 



Box

Smoothening

Not edge preserving

Median

Edge preserving

but some details are lost

NLM

Edge preserving

Better preservation of details

Image filtering: adapt filter choice to dataset and problem



Kernel type – defines the neighborhood configuration, e.g: cube

Kernel connectivity in 3D (for a cube kernel)

2D

3D

18 voxels6 voxels 26 voxels

Image filtering: kernel type and connectivity



Kernel size – refers to the half kernel. Example for a cube type kernel:

2D

3D

Size 1 Size 3 Size 6

Image filtering: kernel size



Gaussian MedianInput 

Examples of filters for removing “salt and pepper noise” (white and black dots on the image):

• Gaussian – smoothening, not effective for removing high contrast local noise    

• Median – fast and efficient but tends to remove small details and to blur the result

Image filtering: denoising filters



Bilateral NLMInput 

Examples of filters for removing “salt and pepper noise” (white and black dots on the image):

• Bilateral – performance in between median filter and NLM

• Non-Local Means – very effective at removing noise while preserving the edges but slow

Image filtering: denoising filters



Sobel

Moments

Unsharp 

Masking

NLM + 

Unsharp 

Masking

• Sobel and Moments (e.g. variance, kurtosis) – edge detection filters

• Unsharp Masking – edge enhancement filter                                                                                                      

Best practice: employ unsharp masking after denoising    

Image filtering: contour detection and enhancement 



Background correction

Basic idea: remove low frequencies in image

Can be done in Avizo by means of different modules:

• Correct Z Drop:                                                                                                                            

fits an arbitrary function of z to the average intensity in each slice

• Block Face Correction:                      

matches masked-slice average intensity to volume average intensity

• Background Image:               

estimates background image, slice by slice, by fitting a 2nd order 

polynomial (to the masked region)

• Shading correction wizard:                                                       

removes image low frequency by dividing the input image by a 

background image

• Background Detection Correction:                   

estimates the background from a B-spline model (for example) with 

specified grid and removes it.



Background correction

Basic idea: remove low frequencies in image

Can be done in Amira by means of different modules:

• Correct Z Drop:                                                                                                                            

fits an arbitrary function of z to the average intensity in each slice

• Block Face Correction:                      

matches masked-slice average intensity to volume average intensity

• Background Image:               

estimates background image, slice by slice, by fitting a 2nd order 

polynomial (to the masked region)

• Shading correction wizard:                                                       

removes image low frequency by dividing the input image by a 

background image

• Background Detection Correction:                   

estimates the background from a B-spline model (for example) with 

specified grid and removes it.



Image pre-processing: exercise 1Image pre-processing: exercise 1

Background correction

Original Corrected

Apply a background correction method in order to obtain a similar result:



Image pre-processing: exercise 1Image pre-processing: exercise 1

Solution

• Example 1: Shading Correction Wizard

• Threshold 75-255

• Normalization 130

• Example 2: Background Detection Correction

• Type: B-spline

•  Size: 5, 5, 5

Tips:

• Visualization setup for comparing images:

• Use multiple viewers with linked camera 
‒ right-click on one of the images in the two viewers

‒ select “Link camera to…” 

‒ then click on the image in the second viewer.

• Assess background

• Use Line Probe module and increase number of 

samples if necessary « take average » (with 

increased radius / long. Width)



Introduction to frequency domain filtering

Fourier Transform

• Filters out low frequency (small intensity variations) or high frequency (strong intensity variations 

e.g. edges) components in images 

Steps

• Compute the Fourier Transform of the image

• Multiply the images Fourier Transform by a filter function (low-pass filter, high pass-filter, etc.)

• Compute the inverse Fourier Transform of the result (the result is mapped back to the spatial 

domain)

Why filter in the frequency domain ?

• Can be much faster than the spatial domain filtering                                                                       

(a convolution in the spatial domain is replaced by a multiplication in the frequency domain).

 



Image filtering: FFT

FFT Filter has two main functioning modes:

• Spatial: removal of periodic structures or stripes

• Frequency: removal of periodic/directional structures and 

spots from the FFT magnitude (advanced-user mode)

Principal use-cases:

• Curtaining artefacts in FIB-SEM                                                                                               

(the module’s parameters are set by default for filtering                                                            

vertical stripes)

• Horizontal stripes in light-sheet microscopy images

Frequency domain filtering can be achieved in Avizo by means of FFT Filter module



Image pre-processing: exercise 1Image pre-processing: exercise 2

Slice Alignment

• Load fib/MoSi2-shear-corrected.am

• Use Volume Edit to create a mask

• Use the different transformers to 

rotate and position a box

• Exclude the trench and upper 

surface

• Use “Cut Outside”

• Use Align Slices on masked image

• Translation only

• Automatic Least Squares Mode

Exercise solution: 

https://youtu.be/HKh4rCr_bIg 

xy slice yz slice

yz slice before and after alignment

https://youtu.be/HKh4rCr_bIg


Image pre-processing: exercise 1Image pre-processing: exercise 3

Background Correction, Frequency Domain Filtering, Denoising

• Background correction                                    

Try:

• Shading Correction Wizard                    or

• Background Detection Correction

• Reduce curtaining artefacts

• FFT Filter

• Denoise

• Filter Sandbox: e.g. NLM, median, bilateral

Exercise solution: https://youtu.be/HKh4rCr_bIg 

Original Corrected

https://youtu.be/HKh4rCr_bIg


See also

Ring Artefact Removal

• Adjusts the mean intensity of the pixels of concentric rings to the 

mean intensity of the whole image

• The rotation axis is assumed to be aligned to the Z-axis of the data-

set’s local coordinate system

• The center of the rings needs to be adjusted manually if:

     the center of the image ≠ the center of rotation during CT acquisition

• Using the settings “Lower Threshold” and “Upper Threshold”, the 

calculation of the mean values can be restricted to a certain intensity 

interval. This might be necessary:
• For objects with inhomogeneous density (large pores, multi-material, etc.)

• For a geometry deviating from a cylinder

• If a cylindrically shaped object was measured de-centered.

• The input data-type must be 16-bit unsigned. 

     Use “Convert Image Type” if necessary.

 



See also

Ring Artefact Removal examples:

original best correction

no intensity range 

adjustment

slightly wrong 

detection axis



Image pre-processing: deconvolution
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Image deconvolution

Iterative Maximum Likelihood Image restoration algorithm. Types of Deconvolution:

• Non-blind (a measured or computed PSF – Point Spread Function –  is used)

• Blind (the PSF is estimated along with the data)

Theoretical PSF generation via Generate Point Spread Function module (Project View → Create Object)

PSF estimation via Extract Point Spread Function module (bead extraction).



Image deconvolution: measuring the PSF

Data after estimating the PSF and 

applying standard deconvolution

Data before deconvolution

Imaging beads with desired acquisition settings (dataset available at …data/deconv/beads.am)

Beads image visualization: Image Ortho Projections + Volren

PSF Estimation: 

• Projection Cursor (for creating Landmarks) 

• Extract Point Spread Function (Adjust centers + Estimate size)



Image deconvolution: 
implemented mathematical PSF models

ConfocalWidefield

For theoretical PSF computation: Generate Point Spread Function module

• Choose type of microscopy: widefield or confocal

• Set microscope parameters: numerical aperture, wavelength, refractive index



Image deconvolution: Blind method

Simultaneous data restoration and PSF estimation

• Can be initialized with a theoretical or measures PSF (that will only be used for the first iteration of the 

algorithm)



Image deconvolution: Standard method

Standard deconvolution example (dataset available at: data/deconv/polytrichum.am & polytrichum-psf.am):

• Resample PSF (optional)

• Apply Deconvolution module in standard mode



Image segmentation: Segmentation Editor
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Segmentation Editor: workroom

Dedicated workroom for interactive segmentation

Selection manipulation

Tools for generating 

selections

List of materials (labels)

Image and Label Field

Configuration of display



Segmentation Editor: workroom

Dedicated workroom for interactive segmentation

Selection manipulation

Tools for generating 

selections

List of materials (labels)

Image and Label Field

Configuration of display



Segmentation Editor: 3D Viewer Position

The default 3D Viewer Position in Amira is “Bottom Right”. You can switch it to “Upper Left” from: Edit -> 

Preferences ->Segmentation



Segmentation Editor: general principle

• Generate selection using the tools available in the selection generation toolbar 

     e.g. Brush, Lasso, Magic Wound (region growing), Threshold, Blow

• Modify selection using the tools available in the: 

• Selection menu

• With keys (shift/ctrl) 

• Selection modification toolbar

• Assign selection to material using the tools available in the selection assignment toolbar

Rules of thumb:

• Only one label per voxel

• Always keep the “Exterior” material

   



•               Brush: 2D painting 

• Right click inside close contour:

     flood fill in 2D

• CTRL: erase 

•               Lasso: 2D & 3D closed contours 

• Generate selections in 2D and 3D by defining 

closed contours 

• “Auto-trace” option: snap to gradient (in 2D)

•               Pick & Move: 2D & 3D 

• Pick and move (translate/rotate) selection

• Can be applied to all slices or current slice only

      

•              Threshold: 2D & 3D masking

• Select all voxels in intensity range

•               Magic Wand: 

• Region growing within intensity range

• CTRL: add new seeds

• Draw 2D barriers (“Draw limit line” option)

•                Blow: 

• Blow a 2D balloon that stick to edges

   

Segmentation Editor: selection tools



Tips:

• “Same Material Only” option available for: Brush and Magic Wand tools

• “All Slices” mode available for: Threshold, Magic Wand and Pick & Move tools

• “Masking” can be enabled: selection only within specified intensity range

   

Segmentation Editor: selection tools



Segmentation Editor: selection modification

Selection modification

• Grow / Shrink (2D or 3D)

• Fill Holes (2D or 3D)

• Smooth (2D only)

• Invert Selection

• Snake: propagate a 2D selection to the 

     next/previous slice, following grayscale intensities

• Interpolate: between selections from parallel slices

• Shape-based interpolation

• Wrap: between selections from orthogonal slices

• Shape-based RBF interpolation

   



Segmentation Editor: materials assignment and 
modification tools

Materials assignment:

• Add selection to material (or replace / substract)

• Materials can be locked

Materials Menu:

• Fill holes (slices only)

• For 3D rather use Selection > Fill Holes

• Smooth Label:

• 2D or 3D smoothing of the label map (shape only)

• Remove Islands: 

• Select small connected components

• Relabel them according to the dominant 

neighboring label



Image pre-processing: exercise 1Segmentation Editor: exercise 1

Bubble segmentation

Use “Thresholding” and “Fill Selection” to segment chocolate bar and bubbles:



Image pre-processing: exercise 1Segmentation Editor: exercise 2

Caramel and biscuit segmentation

• Use “Brush” or “Blow” tool  and “Interpolation” to segment the chocolate mousse. 

• Use “Lasso” tool and “Interpolation” to segment the caramel.

Tips:

• Segment the denoised image rather than 

the noisy one

• "Blow” tool and “Lasso” (Auto trace) are 

sensitive to the visualization range. 

     Adjust the contrast accordingly.



Segmentation Editor: solution to exercises

Tutorial: https://youtu.be/lQsKXRr9Njs

https://youtu.be/lQsKXRr9Njs


Segmentation Editor: solution to exercises

Tutorial: https://youtu.be/lQsKXRr9Njs

For setting the Viewer position as in the illustration, go to Edit-> Preferences->Segmentation-> 

ViewerLayout-3D Viewer Position: Upper Left

https://youtu.be/lQsKXRr9Njs


Visualization of segmentation maps
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Visualization of segmentation maps: main modules

• Voxelized Rendering: displays the 

boundaries of voxels in a 3D volume,

• Create Label Colormap: Generates a label 

colormap with the colors defined in the 

Segmentation Editor

• Colorwash: details on next slide.

• Volren: displays 3d scalar fields volumes. 

• Connect a greyscale volume to ‘Data’ 

port, optionally a labeled image to port 

‘Labels’ 

• Tune Transfer functions and materials.



Visualization of segmentation maps: Color Wash

• Configure an Orthoslice to visualize the 

greyscale image

• Attach the Colorwash to Orthoslice

• Connect a label image to the port ‘Data’ of 

Colorwash

• Adjust label transparency.

• Colorwash can also be connected to a grayscale image, various fusion rules are available 



Visualization of segmentation maps: side by side viewers

• Attach Ortho Slices on 2 datasets

• Set 2 viewers and visibility of Ortho Slices on each viewer

     Tip: pin “Data” port of one Ortho Slice to have it visible on   

     both Ortho Slices  

• Link cameras: right click in a viewer, link camera to... 

left click on 2nd viewer

Tip: For independent viewers, 

make sure to switch off “Link 

object visibility”



Visualization of segmentation maps: linking ports

Linking ports – e.g. “Slice Number” port:

• Activate “Connection Editor” for “Ortho Slice 2”

• Click on the connection icon next to the port and drag over the “Ortho Slice” in the Project View

• Slice number ports are now linked, changing one will change the other simultaneously.

Before linking pots After linking pots



Image segmentation: general principles
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Image Segmentation Principles

179

Thresholding: Binarization of graysale image into Label Image 

8-bit image (28)    has 256 possible numerical intensity values from 0 to 255 

16-bit image (216) has 65,536 possible numerical intensity values from 0 to 65,535

32-bit image (232) has 2,147,483,647 possible numerical intensity values 

179

8-bit image (28)    intensity values from 0 to 255   

16-bit image (216) intensity values from 0 to 65,535               Binary Image (2 possible) values 0 or 1

32-bit image (232) intensity values from 0 to 2,147,483,647 



Image Segmentation Principles

180

Thresholding: Binarization of graysale image into Label Image 

Grayscale (intensity) Image Thresholding (Binary mask) Binary (Label) Image

8-bit image (28)    intensity values from 0 to 255   

16-bit image (216) intensity values from 0 to 65,535                            Binary Image (2 possible) values 0 or 1

32-bit image (232) intensity values from 0 to 2,147,483,647 



Image Segmentation Principles

181

Binarization and Separation Methods

• Watershed segmentation
Automatic edge detection

Marker-based watershed with interactive / automatic markers

• Mathematical morphology
Grayscale/binary morphology, variety of structuring elements

Structure enhancement filter

Membrane enhancement filter

• Correlation-based Segmentation
Segmentation of regions that are co-localized in 

different channels of a multi-channel image

• Thresholding
Global Thresholding, Local Thresholding, Multi-

Thresholding, Auto-Thresholding

Data courtesy: Cell data: Mason Dean & Ronald Seidel (MPI Postdam-Golm), David Knoetel (Zuse Institute Berlin)

Brain data: Leslie Vosshall’s Laboratory at HHMI-The Rockefeller University.
Membrane data: of Biophysical Fluorescence Laboratory Center For Bioimaging Sciences Departments of Biological Sciences & Chemistry National University Of Singapore



Segmentation in image processing workflows

Step 1. Optimise image acquisition:

• Lower noise

• Improve contrast

• Remove artefacts

Step 2. Image pre-processing:

• Noise reduction filters

• Background correction

• Deconvolution

Step 3. Segmentation:

• Thresholding

• Mathematical morphology

• Watershed 

Step 4. Post-processing:

• Separate objects

• Clean segmentation maps



Image segmentation: concepts

Thresholding:

• Binarization: separating the dataset pixels/voxels into object and background.

• Multi-thresholding: separating the dataset pixels/voxels into several groups.

Input data Binarization result

Filtered input data Multi-thresholding result



Image segmentation: thresholding methods

Main modules for performing thresholding:

• Interactive modules:

• Interactive Thresholding

• Used for binarization, allows setting the threshold value interactively 

• Multi-Thresholding 

• Up to five different regions separated by four different thresholds can be extracted

•  All thresholds are set interactively

• Automatic modules:

• Auto Thresholding

• Binary or 3-phase segmentation

• The threshold or (thresholds for 3-phase mode) 

     are computed automatically 

• 4 methods available for threshold computation

• Local thresholding modules:

• Local Thresholding

• Adaptive Thresholding



Image segmentation: thresholding methods example

Multi-thresholding:

• Use Multi-Thresholding module:

• For setting segmentation regions: write a name for each segmentation region

• For setting threshold values: study the histogram – place thresholds between histogram 

lobes

• The intensity range between two threshold values defines a region

• Push Histo button to generate the histogram



Image segmentation: thresholding methods example

Multi-thresholding:

Histogram Multi-thresholding result



Image segmentation: thresholding advanced

High

Low

Length

Hysteresis thresholding

• Starts from regions selected with high threshold

• Propagates into voxels with intermediate intensities - up to a given length

Tip: Use probes, or an interactive thresholding module to help set both threshold values



Image segmentation: thresholding methods example

Local thresholding:

• Use Local Thresholding module:

• For foreground object detection

• For datasets presenting small 

background variations 

• Three methods are available

Example on FoamPoro.am dataset:

Auto-thresholding resultInput slice Local-thresholding result



Image segmentation: thresholding methods example

Adaptive-thresholding:

• Use Adaptive-Thresholding module:

• For thresholding problems that 

require to adapt the threshold 

locally e.g. in the case of 

intensity variation along the data

Example:

Global-thresholding resultInput slice Local-thresholding result



Image segmentation: thresholding methods limitations

Thresholding limitations (e.g. on Multi-thresholding):

• Segmentation artefacts at the boundary between regions (alternative: watershed) 



Image segmentation: advanced concepts
Part 1: mathematical morphology
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Image segmentation: erosion and dilation - binary

Mathematical morphology (mm):

• Structuring element – neighborhood of voxels, defined by:

• Size

• Shape (cube, line, disk, ball)

• Connectivity type – reminder for a cube neighborhood of size 1:

• Basic mm operations:

• Erosion – shrinks the object

• If any voxel in the neighborhood is 0, the voxel is set to 0 in the eroded image, else to 1

• Dilation – grows the object 

• If any voxel in the neighborhood is 1, the voxel is set to 0 in the dilated image, else to 1

18 (common edges) 26 (common vertices)6 (common faces)



Image segmentation: erosion and dilation – binary 

Binary Erosion and Dilation exemple:

Input dataset

Erosion result

Binarized input

Dilation result



Image segmentation: erosion and dilation – grayscale

Erosion and Dilation on grayscale data:

• Erosion 

• Replace voxel value by the minimum intensity value in neighborhood

• Shrinks bright objects

• Dilation 

• Replace voxel value by the maximum intensity value in neighborhood

• Expands bright objects

Dilation resultErosion result



Image segmentation: erosion and dilation – grayscale

Erosion and Dilation on grayscale data:

• Erosion 

• Replace voxel value by the minimum intensity value in neighborhood

• Shrinks bright objects

• Dilation 

• Replace voxel value by the maximum intensity value in neighborhood

• Expands bright objects

Dilation result

Erosion result



Image segmentation: opening and closing - binary

Mathematical morphology operations derived from Erosion and Dilation:

• Opening:

• Erosion + Dilation

     (using the same structuring element - SE)

• All detection objects smaller than the size of the structuring element are removed

• Closing:

• Dilation + Erosion

     (using the same SE)

• All void regions (label=0) smaller than the size of the structuring element are filled



Image segmentation: closing example - binary

Input dataset Thresholding result

Closing result

SE of size 1

Closing result

SE of size 3

Closing: fills small holes (e.g. porosities) and connects detection objects that are close to each other.  

Note: the SE size is 

too small for filling all 

porosities.  



Image segmentation: opening example - binary

Thresholding result Opening resultInput dataset

Opening: removes small structures (clean segmentation results – remove artefacts of small size).



Image segmentation: opening example- binary

Thresholding result Opening resultInput dataset

Opening: removes links (connections) of small size (e.g. separate detection object).



Image segmentation: opening and closing – grayscale

Opening and Closing on grayscale data:

• Opening 

• Removes small bright structures. 

• Closing 

• Removes small dark structures. 

Closing resultOpening result



Image segmentation: opening and closing – grayscale

Opening and Closing on grayscale data:

• Opening 

• Removes small bright structures. 

• Closing 

• Removes small dark structures. 

Closing result

Opening result



Image segmentation: when thresholding does not work

Q: How can we segment the small spots only ? 



Image segmentation: Top-Hat Transform

R: Apply Top-Hat transform and then thresholding



Image segmentation: Top-Hat Transform

Top-Hat (TH) Transform:

• Derived from Opening and Closing

• Highlights small size structures 

• Two types of TH transform:

• White TH:

• Highlights bright structures

• Mathematical expression: Input Data - Opening result

• Black TH:

• Highlights dark structures

• Mathematical expression: Closing result - input data

• Good practice: apply before thresholding in order to corrects non-uniform lighting



Image segmentation: Top-Hat Transform example

Q: How does one get from A to B

A B



Image segmentation: Top-Hat Transform example

BA

Getting from A to B:

• Apply Closing to the Input

• Subtract Input from Closing Result → TH transform image

• Apply thresholding on the TH transform image

• Overlay result on Input (Colorwash) 

Input Closed Input TH transform

Thresholding on 

TH transform
Thresholding result

 overlaid



Image segmentation: Top-Hat in Avizo

Ways of applying (TH) Transform in Avizo:

• Dedicated module

• Interactive Top-Hat

• Use the modules that correspond to the 

    operations composing the TH transform 

• Opening, Closing, Arithmetic/Subtract Image

• Advantage – more flexibility in the 

    choice of the:

• Structuring element

• Thresholding method

• Segmentation Editor:

• Top-hat selection tool 

• TH transform image computation 

• Thresholding on the TH transform image



Image segmentation: Top-Hat in Amira

Ways of applying (TH) Transform in Amira:

• Dedicated module

• Interactive Top-Hat

• Use the modules that correspond to the 

     decomposed TH transform

• Opening, Closing, Arithmetic/Subtract

• Advantage – more flexibility in the 

    choice of the:

• Structuring element

• Thresholding method

• Segmentation Editor:

• Top-hat selection tool 

• TH transform image computation 

• Thresholding on the TH transform image



Image pre-processing: exercise 1Image segmentation: Top-Hat exercise 

Bubble detection in chocolate bar

Apply the necessary module(s) and ports parametrization to create a similar view:



Image pre-processing: exercise 111Image segmentation: Top-Hat exercise 

Solution

e.g. Interactive Top-Hat module – 2 steps:

• (1/2): Computation of the Black TH transform

• (2/2): Thresholding of the TH transform image TH transform 

image histogram



Image segmentation: advanced concepts
Part 2: watershed segmentation
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Introduction to Watershed 

Watershed is the area of land that 

drains into catchment basins



Watershed Transformation 

Any grayscale image can be considered as a topographic surface. 



Watershed Transformation 

If we flood this surface from its minima and, if we prevent the merging of the waters coming from different 

sources, we partition the image into two different sets: the catchment basins and the watershed lines.  



Image gradient

If we apply this transformation to the image gradient, the catchment basins should theoretically correspond to 

the homogeneous grey level regions of this image. 



Image gradient

A 2D Image can be viewed as a Height Map. The gradient of an image, computed in each point as the first 

order spatial derivatives along the x and y directions (dx and dy) gives an estimation of the slope of the 

equivalent landscape that the image might represent. 

Gradient = First Order DerivativesGrayscale Image



Image gradient

The gradient magnitude – computed as the squared root of the sum of the squared spatial derivatives allows 

an estimation of the slope steepness. 



Image gradient

Gradient Magnitude  =  local steepness ~=  contours



Watershed for image segmentation

• Transform grayscale image into gradient image (topographic surface)

• Typically: use the gradient magnitude as landscape image

• Simulate flooding of water (markers) in the landscape image

• Start from low level landscape (local minima)

• Fill the watershed into the basins with respective markers until reach the watershed line (local maxima)

Markers

B,C:  Local minima in the landscape image

D,E:  Ridges (local maxima) in the landscape image



Watershed for image segmentation

• Transform grayscale image into gradient image (topographic surface)

• Typically: use the gradient magnitude as landscape image



Watershed for image segmentation

• Simulate flooding of water (markers: Green, Blue, Yellow) in the landscape image

• Start from low level landscape (local minima)



Watershed for image segmentation

• Fill the watershed into the basins with respective markers (Green, Blue, Yellow) until reach the watershed 

line (local maxima) where two marker sources meet



Marker-based Watershed: Segmentation Editor

• Start with user-defined markers (e.g., brush tool)

• Compute the watersheds (basins) separating the markers (seeds)

• Create a landscape image (Gradient Image) once

• Grow the markers in each Watershed basin



Marker-based Watershed: Segmentation Workroom



Segmentation Editor: 3D Viewer position

The default 3D Viewer position in Avizo is “Upper Left”. You can switch it to “Bottom Right” from: Edit -> 

Preferences ->Segmentation



Image segmentation: Marker-based Watershed

1

2



Image segmentation: Marker-based Watershed

3

4 4

4



Image segmentation: Marker-based Watershed

5



Image segmentation: Marker-based Watershed



Image segmentation: Marker-based Watershed

6

7

7

7



Image segmentation: Marker-based Watershed

8



Image segmentation: Marker-based Watershed



Image segmentation: Marker-based Watershed

9

10

10

10



Image segmentation: Marker-based Watershed

11



Image segmentation: Marker-based Watershed



Image segmentation: Marker-based Watershed

12

13

14

Project 

workroom



Image segmentation: Marker-based Watershed

15



Image segmentation: Marker-based Watershed

Ortho Slice Voxelized Rendering



Image segmentation: Watershed Segmentation Wizard

• Define markers for phases via thresholding

• Mask out regions with high gradient magnitude

• Expand markers with watershed



Image segmentation: Watershed Segmentation wizard



Image segmentation: Watershed Segmentation wizard



Image segmentation: Watershed Segmentation wizard



Image segmentation: Watershed Segmentation wizard



Image segmentation: Watershed Segmentation wizard



Image segmentation: Watershed Segmentation wizard



Image segmentation: Watershed Segmentation wizard



Image segmentation: Watershed Segmentation wizard



Image pre-processing: exercise 1Watershed in Segmentation Editor: exercise 

Multi-phase segmentation of chocolate bar



Watershed in Segmentation Editor: exercise 

Solution



Watershed in Segmentation Editor: exercise 

Solution



Image segmentation: post-processing
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Segmentation post-processing: morphological filtering

• Binary mathematical morphology 

• Interactive Shrink & Grow in Segmentation Editor

•  Opening and Closing

• Fill Holes

• Dilate + Fill Holes + Erode: may close more open cavities/pores

• Remove Small Spots

• Border Kill: removes objects touching image bounding box



Segmentation post-processing: object separation

• Separate Objects

• Smaller ‘Extent’ value means more separation

• Criterion relates to convexity of the particles

• See tutorial “Separating, Measuring and Reconstructing -> Separation using 

Watershed step by step”



Image pre-processing: exercise 1Segmentation post-processing: exercise

Separate objects after sand-pack segmentation

• Data to use is Data/Sandpack/SandPack128.am

• Follow steps given in tutorial “Separating, 

Measuring and Reconstructing -> Separation 

using Watershed step by step”



Surface generation
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Open the label image chocolate-bar-labels (data>tutorials) then attach Generate Surface module to the label 

image. In the properties window, using the default parameters:

• Data: chocolate-bar-labels.am (label image)

• Border Settings: Adjust Coords

• Algorithm Mode :  repeatable

• Smoothing: Unconstrained Smoothing (use None/Constrained smoothing to preserve thin structures)

• Smoothing Extent: 5

Surface reconstruction



The result surface chocolate-bar-labels.surf can be exported by right click at the surface (or left click and then 

go to > File) and select Export Data As then select the format (e.g. .stl or .obj) to export. 

Surface data export



Attach Surface View to the chocolate-bar-labels.surf to visualize the surface.

• Data: chocolate-bar-labels.surf 

• Draw Style:  Transparent

• Colors: patch

• Base Trans: 0.5

Surface View usage, tips & tricks: https://youtu.be/zXq3A4bKcFg

Surface view

https://youtu.be/zXq3A4bKcFg


Activate Simplification Editor in the properties port of chocolate-bar-labels.surf.

Simplification Editor

• Simplify: faces 18000 (0 max & min dist)

• Action:  Simplify now

Surface simplification



180000 faces

Surface simplification example

18000 faces



After reconstruction, the surface can be coarse: for refining, remeshing is necessary.

Attach Remesh Surface module to the chocolate-bar-labels.surf.

• Data: chocolate-bar-labels.surf 

• Objective:  Best isotropic vertex placement

• Desired Size: #vertex = 216991, #tris = 433982, % = 50

• Interpolate Original Surface: none

• Contour Options: contract boundary edges

Surface remeshing



Surface remeshing

Original surface After simplification After remeshing

Dataset: Chocolate-bar-labels.surf 



Image pre-processing: exercise 1Surface view: exercise

Tuning Surface View module

Load motor.labels (data->tutorials) then use Generate Surface and Surface View to obtain a similar view.



1. Generate Surface: 

• Smoothing: Existing Weights

2. Simplify Surface:

• 18000 faces

3. Surface View:

• Draw Style: Outline

• Colors: Patch

• Buffer: Remove Material3

Data visualization: exercise 3

Solution



Image pre-processing: exercise 1Surface view: exercise

Tuning Surface View module

Load lobus.labels (data>tutorials) then use Generate Surface and Surface View to obtain a similar view. 



1. Generate Surface: 

• Smoothing: Existing Weights

2. Simplify Surface:

• 18000 faces

3. Surface View:

• Draw Style: Outline

• Colors: normal

• Buffer: Remove Medulla

Data visualization: exercise 3

Solution



Quantification
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Quantification on segmentation results

Q: How can one identify segmentation objects and extract measurements and statistics ? 



Label segmentation objects and extract measures 

A: Label Analysis module. It

• Generates a label image: a unique label is assigned to each connected component

     (if input is binary)

• Allows extracting individual measures for each label object

• Allows extracting global statistics

• Intensity input (optional): allows extracting gray level statistics (e.g. mean, min, max)



Label Analysis

A: Label Analysis module. Default port initialization:

• “basic” Measures – group of pre-defined measures:

• Volume3d

• Area3d

• BaryCenterX

• BaryCenterY

• BaryCenterZ

• Mean 



Label Analysis

Label Analysis results for default ports initialization.

Global statistics Individual measuresLabeled image (overlaid on input)



Label Analysis

Different tools are available for manipulating the spreadsheet measures:

• E.g. “Sort descending” sorts the values of a column in descending order.



Label Analysis: pre-defined measures list

Some measures are pre-defined and ready to use by “Label Analysis” module.

For checking the list of pre-defined measures:

• Go to “Label Analysis” Help page

• Click on “list of available measures”



Label Analysis: pre-defined measures list

Help page with the list of pre-defined individual label measures.



Label Analysis: custom measures list, custom measures

A custom measures list with pre-defined measures can be created:

• Click on a measure on the left side to add it to the group

• Select a measure added to the group (right side) and click on “Deselect the measure form the 

measure group” to remove it from the group.



Label Analysis: custom measures list

Custom measures can also be created and added to the custom measures list. E.g. sphericity:

• Click on “Create a new measure” icon

• Type the name of the custom measure

• Type the measure in the “Measure Editor” (it’s green if valid, red if not).



Quantification: removing unwanted detection

Q: how can one remove parasite detection from a label image and its corresponding measures in the 

measures spreadsheet ?

E.g.: for the segmentation example on chocolate bar, remove the label corresponding to background 

and keep only the porosity labels and measures  

Unwanted detection to be removed



Quantification: removing unwanted detection

A: Analysis Filter module

• Filters out from the measures spreadsheet, labels that do not fulfill a filtering criterion

• Same behavior on the label image label image (when provided as input – optional)

• Filtering criterion: choose one (or more) measures that allow to discriminate the parasite detection

     and write filtering formula.



Quantification: removing unwanted detection

Analysis Filter result for the filtering formula “Volume3d < 1e-7”:



Shape analysis: represent objects as ellipsoids

Example: porosities analysis in FoamPoro.am 

Step 1: 

• Do a binary segmentation of the porosities 

Segmentation workflow

Porosities before and after object separation



Shape analysis: represent objects as ellipsoids

Example: porosities analysis in FoamPoro.am 

Step 2:

• Apply Label Analysis with “Standard Shape 

Analysis” 

• Measures for shape analysis:

• Eigenvectors

• Eigenvalues



Shape analysis: represent objects as ellipsoids

Example: porosities analysis in FoamPoro.am 

Step 3:

• Generate Bounding Box and Ellipsoid 

representation for individual labels via 

“Spreadsheet to Point Cloud” module 

• Check “Bounding Boxes” Output

• Check “Point Cloud” Output and “Fill 

Bounding Boxes” for ellipsoid 

representation 



Shape analysis: represent objects as ellipsoids

Example: porosities analysis in FoamPoro.am 

Step 4:

• Visualization:

• Line Set View for Bounding Boxes

• Tensor View for the ellipsoids (click on 

“Apply” for generating the visualization)

Bounding Boxes and 

Ellipsoid representationBinarisation representation



Surface measurements and statistics

Other Surface measurements and statistics modules are available in the “Measure and Analyze” object 

category (for access: right click on the surface object in the pool).



Extract skeletons and graphs

For filamentous data, automatic extraction of centerlines with local thickness can be done via 

Auto Skeleton module. It generates a spatial graph data:

• Spreadsheet with information on nodes, points (thickness info available too), and segments

• Can be visualized with:

Example: neuron.am and Neuron-SpatialGraph.am data in …\data\tutotials\neuron

Neuron spatial graph Neuron data 
Neuron data and spatial graph 

superposed



Measurements and annotations
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Units management

• Units are necessary to interpret numbers as physical values.

• Two “types” of units must be distinguished:

• Working units: 

•  All calculations are done in those units.

•  Can only be changed before loading the first data-set in the project.

• Display units:

•  Used to display numerical values.

•  Can be changed anytime, independently of working units

Note: Display Units do not change data.

Use adequate working units because of the impact on numerical precision!



Units management

• Units management is implemented for spatial size only (coordinate and angle units).

• Units management settings can be accessed in preferences: 

• Default is: 

• enabled 

(“Spatial information only”)

• default unit: nm



Units management

Loading data

• When loading data, either spatial information is given in the same unit (default coordinate units), 

or the units of each data-set must be set correctly independently.

• Default setting

• Recommended:

• If you are always using data with the same unit, set the appropriate unit here:

• Alternatively, switch off units management. 

Set to your most likely unit, as 

this will be pre-selected in the 

Units Editor dialog.



Units management

Beware:

• If you save a project, the information about working units is saved with it

• If you load a project having working units set differently from your current ones, the settings from the 

project are loaded and applied permanently, until you explicitly change it back! 



Units management

Display units:

• May be changed anytime, either via the preferences, or via the Viewer Window settings.

• Affect all measures with units management, e.g.:



Performing measurements 

Measurement tool:

• invoke with

• Measure button in viewer toolbar (shortcut “M”)

• Via “Create object … → Annotations → Measurement”

• Different measurements types available 

• works on visualization modules in

• 2D, e.g. Ortho Slice, Slice

• 3D, e.g. Surface Rendering, Volume Rendering, Voxelized Rendering



Performing measurements 

Measurement tool:

• is active when Measurement module is selected



Performing measurements 

Measurement module:

• snapping possible – click on a point 

• within search window (semi-transparent square)

• to min, max, or gradient (min or max)

Snapping example 



Performing measurements 

Measurement module:

• editable properties:

• snapping

• text (title and note)

• callout and shape                                                                                                            

properties

• measure points

(colors, font, etc.)

Select point to modify (#1 or #2)
Edit x, y, z coordinated 

of the selected point



Probing data value

Quick Probe

• show value of data at mouse position (interactive mode should be on)

• works with e.g. Slice, Ortho Slice, and Volume Rendering

• 2 modes:

• Continuous update

• Click for update (Shift + Click)

   ➔ prefer “Click for update”

• value is shown in status bar



Probing data value

Point Probe

• get callout with position and value

• select Point Probe and click with middle mouse button to pick a location, or move the handles

• works with e.g. Ortho Slice, Slice, Voxelized Rendering

• editable callout settings

• local averaging

• hide dragger:



Probing data value

Line Probe (2D and 3D)

• evaluate the data-values along a straight line

• select point to modify (#1 or #2) – to change the coordinates in the text boxes or   

• click with middle mouse button to pick new location or use handles to position the points

• for arbitrary orientation de-select “orthogonal”

Display line-profile in plot window:

• adjust number of sample-points

• possibility for local averaging



Probing data value

Spline Probe

• similar to Line Probe, but:

• arbitrary number of control points

• sampling along smooth, curved Spline   



Probing data value

Histogram

• distribution of values in the data-set

• optionally limited to ROI or mask

• adjust settings:

• range

• number of bins

• absolute/relative counting

• linear/logarithmic Y-axis



Probing data value

Histogram

• further settings:

• axis control for X and Y:

• range

• number format

• tick-marks

• linear/log

• labels

• …



Spreadsheet visualization

• Plot Spreadsheet

• Histogram

• Spreadsheet To Point Cloud + Point Cloud View for the display

• e. g. create bounding-box information and orientation tensors



Spreadsheet visualization

• Spreadsheet To Point Cloud + Point Cloud View for the display

• e. g. point cloud as sphere visualization



Displaying plots in the main viewer

Normally, all kinds of plots are displayed in a separate viewer window. 

With Plot In Viewer, plots can be displayed in the main viewer window(s).

• can be attached to:

• Histogram

• Point Probe

• Line Probe

• Spline Probe

• Plot Spreadsheet

• options:

• position

• size

• transparency

• frame



Annotation: Scale Bar and 2D Scale Bar

There are two types of scale-bars available:

2D Scale Bar

• attached to a slice object

• correct also in perspective (      ) view!

• options: length, position, color, … 

Scale Bar

• located in the 3D viewer

• invoked via click on background and 

“Create object → Annotations → Scalebars”

• only meaningful in orthographic (      , parallel) view! 

(because of perspective shortening)

• options: length, position, color, label, font, ticks, … 



Annotation: Colorbar

Attach Colormap Legend to the display module.

• options: 

• size

• vertical

• background

• font

• title

• custom text

• Histogram

Tip: set alpha=0 to 

hide the histogram 



Annotation: Colorbar

If you want to get rid of the checkerboard-pattern:

• in the display-module’s (e.g. Color Wash) colormap port: 

select “Options → Edit colormap”

• in the Colormap Editor:

set transparency to “Opaque”



Annotation: Axes, Caption

Axes

• visualization of global coordinate system:

• no data-set connected

• invoked via click on background and “Create object → Annotations → Axes”

• visualization of local coordinate system:

• connected to a data object

• invoked via the object’s context menu (“Annotate → Axes”)

• default coloring convention: X: red, Y: green, Z: blue

Caption

• any text in the viewing plane of the viewer

• invoked via click on background and 

“Create object → Annotations → Caption”

• options: position, text, color, font



Data registration and alignment
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Load chocolate-bar.am then attach Volume Rendering, Bounding Box and Slice to the dataset (oblique view).

Alignment to an oblique plane: example



Rotate Slice using rotate mode in Slice properties port (activate trackball) to rotate to the desired tilt angle.

Alignment to an oblique plane: example



Attach Resample Transformed Image to chocolate-bar.am and set reference to Slice. 

Alignment to an oblique plane: example



At Resample Transformed Image properties select Interpolation: Standard, Mode: extended then click Apply. 

Alignment to an oblique plane: example



Attach another Bounding Box to chocolate-bar.transformed and visualize with Volume Rendering. 

The transformed result is now aligned with Slice (in green).

Alignment to an oblique plane: example



Data registration: introduction

• General concepts

• All datasets are positioned in ‘physical’ space

• This position is control by a ‘Transform’

• Registration

• Optimization of the ‘alignment’ with respect to the degrees of freedom given by the ‘transform’

• Difficult mathematical problem, sensitive to the initialization

• Avizo can register:

• Volume to volume (grayscale or label images)

• Surface to surface

• Using Linear transform: translation, rotation, optionally scaling and shearing



Data registration: introduction

• General concepts

• All datasets are positioned in ‘physical’ space

• This position is control by a ‘Transform’

• Registration

• Optimization of the ‘alignment’ with respect to the degrees of freedom given by the ‘transform’

• Difficult mathematical problem, sensitive to the initialization

• Amira can register:

• Volume to volume (grayscale or label images)

• Surface to surface

• Using Linear transform: translation, rotation, optionally scaling and shearing



Open motor.part1-reference.am and motor.part2-model.am (data -> registration) then attach Volume 

Rendering to each dataset. 

Data registration: Transform Editor module



In the properties window of motor.part2-model.am, activate Transform Editor, the transform box will appear.

Data registration: Transform Editor module



Move the handle box and bring motor.part2-model.am (in yellow) to overlap with motor.part1-reference.am (in 

green) as much as possible. 

Data registration: Transform Editor module



Attach Register Images to motor.part2-model.am and set the reference to motor.part1-reference.am. 

• Transform: Rigid

• Register:  3D

• Prealign:  Align centers & Align principal axes

• Metric:  Normalized Mutual Information

Data registration: Register Images module



Data registration: Resample Transformed Image module

Attach Resample Transformed Image to motor.part2-model.am to apply the transformation (otherwise the 

transformation will be available for visualization only).



Image fusion & stitching

Attach Merge module to motor.part2-model.transformed and set motor.part1-reference.am as a reference. 

Merge using standard interpolation with blend option.



Image fusion & stitching



Open chocolate-bar.part1-reference.am and chocolate-bar.part2-model.am (data > registration) then attach 

Volume Rendering to each dataset. 

Data registration: Transform Editor module



In the properties window of chocolate-bar.part2-model.am, activate Transform Editor, the transform box will 

appear.

Data registration: Transform Editor module



Move the handle box and bring chocolate-bar.part2-model.am (in yellow) to overlap with chocolate-bar.part1-

reference.am (in green) as much as possible. 

Data registration: Transform Editor module



Attach Register Images to chocolate-bar.part2-model.am and set the reference to chocolate-bar.part1-

reference.am. 

• Transform: Rigid

• Register:  3D

• Prealign:  Align centers & Align principal axes

• Metric:  Normalized Mutual Information

Data registration: Register Images module



Data registration: Resample Transformed Image module

Attach Resample Transformed Image to chocolate-bar.part2-model.am to apply the transformation (otherwise 

the transformation will be available for visualization only).



Image fusion & stitching

Attach Merge module to chocolate-bar.part2-model.transformed and set chocolate-bar.part1-reference.am as 

a reference. Merge using standard interpolation with blend option.



Image fusion & stitching



Image pre-processing: exercise 1Data registration: exercise 

Register and merge parts of motor data

Register and merge the motor parts (…data/registration/motor.part1-reference.am & motor.part2-model.am)



Image pre-processing: exercise 1Data registration: exercise 

Register and merge parts of chocolate bar data

Register and merge the chocolate bar parts 

(…data/registration/chocolate-bar.part1-reference.am chocolate-bar.part2-model.am)



Open Pump-bracket-CAD-model.surf and Pump-bracket-CT-scan.am (…data/pump-bracket) then generate a 

binary image (thresholding) and then generate surface from Pump-bracket-CT-scan.am and attach Surface 

View to both surfaces.

Nominal-Actual comparison



In the properties window of Pump-bracket-CT-scan.surf, activate Transform Editor, the transform box will 

appear.

Nominal-Actual comparison example



Move the handle box and bring Pump-bracket-CT-scan.surf  to overlap with Pump-bracket-CAD-model.surf 

as much as possible. 

Nominal-Actual comparison example



Attach Align Surfaces to Pump-bracket-CAD-model.surf and set the reference to Pump-bracket-CT-scan.surf. 

• Options: iterate

• Transformation:  rigid

• Stop:  relative RMS = 0.001, max iter = 15

• Align:  Surfaces

Nominal-Actual comparison example



Nominal-Actual comparison example



Attached Surface Distance module to Pump-bracket-CAD-model.surf  (surface 1) and Pump-bracket-CT-

scan.surf (surface 2). 

• Direction: Surface 1->2

• Output: Distance

• Maximal Distance: 1

• Above Threshold: 0.5

Nominal-Actual comparison: e.g. Surface Distance



Visualize distance with Surface View, set color map to Physics

Nominal-Actual comparison: e.g. Surface Distance



Landmark-based registration: introduction

• Landmarks are useful for registration and alignment of multiple 3D images. 

• It allows you to store multiple sets of corresponding marker positions. 

• The data type can also be used to represent a simple list of 3D points. 



Landmark-based registration: example

Open chocolate-bar.part1-reference.am and chocolate-bar.part2-model.am (data -> registration) then attach 

Volume Rendering to each dataset. 

In the properties window of chocolate-bar.part2-model.am, activate Transform Editor, the transform box will 

appear. Move the handle box and bring chocolate-bar.part2-model.am (in yellow) to align with chocolate-

bar.part1-reference.am (in green) as much as possible. 

Once satisfied apply Resample transform Image to save the transformed dataset.



In Project View, right-click and “Create Object”, select Landmarks (2 sets) (Points And Lines).

Landmark-based registration: example



Activate Landmark Editor in the properties port of Landmarks-2-sets, Landmark View will appear. 

Landmark-based registration: example



In Landmark-View select to show lines. Then go back to Landmarks-2-sets to start adding points by click on 

chocolate-bar.part1-reference.am (yellow dots) and connect to chocolate-bar.part2-model.am (light-blue 

dots). Line sets between the two volumes will be shown. Rotate the volumes and add more points and lines 

to connect common landmarks between the two volumes. Do not make crossing lines.

Landmark-based registration: example



Open Tcl console, then come back to “Project View” and click on “Landmarks-2-sets”. Next go back to Tcl 

Console and then press “Tab” to activate- > “Landmarks-2-sets” and input “computeLinearTransform 1 0 0”:

• “Landmarks-2-sets” computeLinearTransform 1 0 0

Press enter.

Landmark-based registration: example



Go back to Project View and click on chocolate-bar.part2-model_transformed.am. Then go back to Tcl 

Console and then press “Tab” to activate -> “chocolate-bar.part2-model-transformed.am” and input 

setTransform and paste the values from previous step:

• “chocolate-bar.part1-reference.am” setTransform 0.999631 -0.0174218 -0.020835 0 0.0176621 0.999779 

0.0114049 0 0.0206318 -0.0117689 0.999718 0 -0.375237 0.593657 -18.5194 1

Press enter.

Landmark-based registration: example



Registration result:

Landmark-based registration: example



Artificial Intelligence
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Artificial Intelligence

349

What is Deep Learning

Example Data Model Train

New Data Apply Model

has patterns finds patterns recognizes patterns

Prediction

 Deep learning is a machine learning 

technique that teaches computers to do 

what comes naturally to humans: 

 Learn by example



AI-Powered Deep Learning

• Learn by example

• Automate tedious tasks 

• Solve challenging feature identification

• Improve accuracy & time to results

350

Trained 

Model

Training Image Ground Truth Image
New Images

Predicted Results



Convolution

351

 In mathematics, convolution is a 

mathematical operation on two 

functions (f and g) that 

produces a third function () that 

expresses how the shape of 

one is modified by the other.

 The term convolution refers to both 

the result function and to the 

process of computing it.



Deep Learning Neural Network



Deep Learning Neural Network



Neural Network



Neural Network



Neural Network



Neural Network



Animation generation

358 Proprietary & Confidential | authoremail@thermofisher.com



Animation: Camera Path (Rotation)



Animation: Camera Path (rotation)

Open chocolate-bar.am (data > tutorials) then attach Volume Rendering to the dataset. 



Animation: Camera Path (rotation)

Attach Camera Path

Right-Click anywhere in 

the project view

- Create Object



Animation: Camera Path (rotation)

Attach Camera Path

Right-Click anywhere in 

the project view

- Create Object

- Camera Path



Animation: Camera Path (rotation)

Camera Path

Click on the Camera-Path 

module 

- Properties



Animation: Camera Path (rotation)

Camera Path

Click Camera Path Editor icon

(top-right) to start adding key 

frames. 

A small camera path view will 

also appear.



Animation: Camera Path (rotation)

Camera Path

Click Add to start 

adding key frames

For each key frame;

- Turn, rotate, zoom 

data in or out

- The path of camera 

rotation will be 

shown in the small 

Camera Path Viewer



Animation: Camera Path (rotation)

Camera Path

Click the small viewer 

to close Camera Path 

Editor when finish with 

key frames

(or click at the Camera 

Editor icon one more 

time).



Animation: Camera Path (rotation)

Camera Path

Click Play button to 

preview the animation



Animation: Camera Path (rotation)

Making movie

Right click at Camera-

Path module to attach 

Movie Maker module



Animation: Camera Path (rotation)

Movie Maker

Set the parameters 

(Filename field is 

mandatory) then click 

Apply to create a movie 

file.



Animation: Camera Path (rotation) movie example



Animation Workroom: Animation Director



Animation Workroom: Animation Director

Animation Director

Attach Clipping Plane to 

the dataset and “clip”



Animation Workroom: Animation Director

Animation Director

Then activate the 

Animation workroom.

The Animation Director 

will appear.



Animation Workroom: Animation Director

Translation 

Animation 

1. Start with the 

Timeline at 

00:00:000

2. In Clipping Plane 

Properties translate 

to 0%.

Pay attention to the 

clipping direction: full 

volume should be 

visible at 0% 

(Translate). 12

2



Animation Workroom: Animation Director

Translation 

Animation 

1. Start with the 

Timeline at 

00:00:000

2. In Clipping Plane 

Properties. Translate 

to 0%

3. Hide the Clipping 

Plane bounding box. 

3



Animation Workroom: Animation Director

Translation 

Animation 

 4. Click the 

Stopwatch button 

next to Translate (%) 

in Clipping Plane 

properties to start 

adding the first key 

frame (Translation) to 

the timeline at 

00:00:000.

4



Animation Workroom: Animation Director

Translation 

Animation 

5. Move the timeline 

bar to 00:03:000

6. Translate to 50 %

7. Add a key frame 5

6

7



Animation Workroom: Animation Director

Translation 

Animation 

Repeat the steps

8.Move the timeline 

bar to 00:06:000

9. Translate to 80 %

10. Add a key frame
8

9

10



Animation Workroom: Animation Director

Translation 

Animation 

Repeat the steps

11.Move the timeline 

bar to 00:09:000

12. Translate to 0 %

13. Add a key frame
11

12
13



Animation Workroom: Animation Director

Translation 

Animation 

14. When done, bring 

timeline bar to 

00:00:000 

15. Set the limit of 

the animation at 

00:09:000

16. Click Play button 

in Animation Director 

to preview the 

animation.

14

16
15



Animation Workroom: Animation Director

Translation + Rotation

Animation 

17. At time 00:00:000

18.Click on Camera-

Path module (with 

previously created 

rotation key frames).

19. Make sure to have 

Time 0 in Camera Path 

properties port before 

clicking on Stopwatch 

button next to Time.

Select Time value to 

add to Animation 

Workroom. 

17

19

18



Animation Workroom: Animation Director

Translation + Rotation

Animation 

17. At time 00:00:000

18.Click at Camera-Path 

module (with previously 

created rotation key 

frames).

19. Make sure to have 

Time 0 in Camera Path 

properties port before 

clicking on Stopwatch 

button next to Time.

Select Time value to 

add to Animation 

Workroom. 

17

19

18



Animation Workroom: Animation Director

Translation + Rotation

Animation 

20. Move the timeline 

bar to 00:03:000

21. Move Camera Path 

Key frame to time 30

22. Add a key frame

20

21

22

22



Animation Workroom: Animation Director

Translation + Rotation

Animation 

Repeat the steps

23. Move the timeline 

bar to 00:06:000

24. Move Camera Path 

Key frame to time 60

25. Add a key frame

23

24

25



Animation Workroom: Animation Director

Translation + Rotation

Animation 

Repeat the steps

26. Move the timeline 

bar to 00:09:000

27. Move Camera Path 

Key frame to time 90

28. Add a key frame

26

27

28



Animation Workroom: Animation Director

Translation + Rotation

 

Animation 

29. When done, bring 

timeline bar to 

00:00:000 

30. Click Play button in 

Animation Director to 

preview the animation.

Please note that the 

animation limit was 

already set at 

00:09:000

29

30



Animation director: movie generator

Movie Creation

Activate Movie Creation in 

Animation Director and input 

all parameters as needed.

Then click Create Movie.



Animation Workroom: Animation Director movie example
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